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II.
Abstract— The paper presents the remote laboratory practice
in computer added design of integrated circuits within the
European project “Remote-labs Access in Internet-based
Performance-Centered Learning Environment for Curriculum
Support”. The ECAD laboratory at the Technical University of
Sofia implemented a remote access to the professional
microelectronics software (very expensive and running only on
workstations) and is being used by the students from the MSc
degree for working on their projects.
Keywords-remote laboratory access, computer added design,
e-learning, curriculum, European project.

I. INTRODUCTION
The RIPLECS project focuses on sharing the
technological and human resources available at each partner
university to strengthen the virtual mobility by courses,
based on ECTS, delivered by other institutions abroad using
virtual learning facilities, and to be used in the common MSc
programme in information and communication systems. The
Electronics Computer Added Design (ECAD) laboratory at
the Technical University of Sofia (TUS) implemented a
remote access to the professional microelectronics software
[1] (very expensive and running only on workstations) and is
being used by the students from the MSc degree for working
on their projects.

WHY WAS THIS REMOTE CAD LABORATORY ACCESS
DESIGNED?

The use of Information Technology (IT) infrastructure in
learning environment is a demanding challenge. The
increasing system complexity requires the setup of powerful
computer systems, the use of high performance networks, the
acquisition of trained IT personnel to manage these hardware
and software platforms. Moreover, computing power
requirements, joint to learning tool complexity, are pushing
academic institutions to build private data centres to host
applications and give the service to students and academic
staff. Traditional computing architectures are inherently
inefficient from the point of view of both energy wasting,
and utilization efficiency. Statistics shows that the average
utilization factor of a server in a traditional data centre is less
than 10%, and decreases with the reduction of the IT
infrastructure complexity. Hardware virtualization can
improve efficiency, but it does not solve problems related to
management costs, as local data centre maintenance is
mandatory.
There are few individual research teams, laboratories or
companies that can reasonably claim to be able to respond to
the technological challenges in the sector of micronanoelectronics. Even the big companies in the sector work
with a common use of R&D resources (as Motorola & ST
Microelectronics etc) [2]. No one university can afford the
necessary infrastructure, technology and experts in all fields
of the multidisciplinary science of micro- and
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nanoelectronics. That is why a collaborative approach in
delivering education in the new technologies is needed [3].

IV. COURSE ‘ADVANCED ELECTRONICS FOR
INFORRMATION AND COMMUNICATION SYSTEMS’

In RIPLECS project we will share our laboratory
experiences, CAD tools, project ideas, and common
infrastructures.

The RIPLECS project is a successor of the IPLECS
project in which the master degree courses for the curriculum
on information and communication systems were developed
and tested [6, 7].

III.

BACKGROUND

The ECAD laboratory at the Technical University of
Sofia implemented a remote access to the professional
microelectronics software (very expensive and running only
on workstations) and is being used by the students from the
MSc degree for working on their projects [1].
At Politecnico di Torino (POLITO) an Internet, cloud
based architecture has been developed to make available
standard desktop applications for microelectronics education
outside of the traditional labs [4]. This experimentation
started two years ago, with a couple of microelectronics and
microsystems courses, which require the use of complex
CAD software. They were usually held in traditional labs
built up with standard desktop PCs.
A WEB-based CAD tool TAMTAMS [5] was developed.
This tool is based on an open, flexible and simple structure,
which allows predicting microelectronic system level
features starting from technology variables. It is modular and
based on a clear dependency tree of modules, each related to
a model of specific quantities (e.g. device currents, circuit
delay, interconnects noise, ....). Models can be compared and
sensitivity to parameters can be observed. The tool is now
limited to a specific subject, but it is an evident example of
the framework to be developed in this project, and it is one
of the already present solutions that will be used as starting
point for project development.
Right now, a private cloud of 10 virtual servers is
currently up and running and further extensions of the
system for courses in other disciplines is under development.
The same research group is currently actively developing
architectures and tools to automate horizontal scaling of
cloud based infrastructures according to Service Level
Agreement (SLA) for Platform as a Service (PaaS) models,
for a national.
In this new approach a scaled down cloud has been setup,
and students laptops are the clients used to connect to cloud
virtual machines, via the wireless network available inside
the campus. Feedback has been collected, through surveys
distributed at the beginning and at the end of courses, with
specific questions on the IT infrastructure performance and
learning scheme effectiveness. The feedback of the users was
very good. Performance data were collected, too, to monitor
CPU, memory, and I/O bandwidth requirements, related to
the number of students connected, and to specific CAD tool
needs. Based on these proofs of concept, a larger learning
environment was built, increasing both the number of
courses as the number of students accessing the computing
environment.

The presented in this paper remote laboratory practice
access is designed for some of the tasks for performance in
the course ‘Advanced electronics for ICS’.
The learning outcomes for the course and the tasks for
performance are given in Table 1.
V.

REMOTE PROFESSIONAL CAD SYSTEM

The ECAD laboratory at the Technical University of
Sofia implemented a remote access to the professional
microelectronics software (very expensive and running only
on workstations) and is being used by the students from the
MSc degree for working on their projects.
In RIPLECS the ECAD laboratory at the Technical
University of Sofia will provide remote access to
CADENCE [4] for the laboratory practice of the MSc
students in the two courses: Microelectronics and Advanced
electronics for ICS.
The common computer architectures will be exploited to
expose specialized interfaces to standard desktop CAD tools,
provided with the necessary customized script interfaces. In
this way, expensive software can be shared between
academic institutions, and infrastructure costs can be shared
accordingly. This approach maps to the SaaS (Software as a
Service) paradigm. Each institute maintains its own licenses,
for understandable legal reasons, it is not possible to share
the licenses. But the license request is a negligible power
request in comparison to the computation required for
running the CAD itself. So the scenario is that the client
requests locally the license, but immediately after has
available the computation power given by the cloud
infrastructure.
The technique for the remote access to the software at the
ECAD is the following. Under Windows OS the remote
access to CADENCE is implemented using two application
programs - Secure SHell (SSH) and Xming:


The first one provides a secure connection to the
server where CADENCE is installed and will be
running.



The second one is a X Window emulator (X
Window Server for Microsoft XP/2008/Windows7),
which gets the graphical information from the server
and displays it on user's computer screen.

For security reasons a tunnelling of the display can be
provided by SSH over the port, which SSH uses.
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TABLE I.

LEARNING OUTCOMES FOR THE COURSE ‘ADVANCED ELECTRONICS FOR ICS’

MODULE
Fundamentals of MOS and
bipolar integrated circuits
and multichip modules for
ICS

TASK
Task 1 MOS integrated circuits

Basic VLSI circuits in
computer architectures

Task 3 Microprocessor systems

Task 2 Multichip modules

Task 4 Microprocessor architectures
Task 5 Computer platforms

VLSI circuits in
telecommunication and
satellite broadcasting

Memories

Task 6 Fundamentals of high frequency
electronics

To discuss the reasons for the move from the
lumped-element circuit theory to distributed
circuit elements and transmission-line theory
and to explain the effects of reflection,
polarization, scattering, diffraction and
atmospheric absorption in the study of
microwave propagation.

Task 7 High frequency circuits

To explain the principle and the construction of
RF and microwave monolithic circuits and
multichip modules.
To describe the principle and hardware of
SDSP microprocessors, and to discuss the new
trends in the emerging platforms.
To explain the principle of Block RAM
(DRAM, SRAM), Ferroelectric RAM, their
characteristics and parameters and to be able to
design RAMs.
To explain the principle of ROM, EPROM,
EEPROM, NVRAM, Battery RAM, Flash
memories, their characteristics and parameters
and to be able to design ROMs.
To explain the principle of data memorisation
of hard discs and optical discs, their
characteristics and parameters.
To be able to select the appropriate kind,
characteristics and parameters of memory for a
concrete ICT application.
To explain the physical basis and the
functioning of liquid crystal devices
To identify the characteristics and parameters
of semiconductor photodetectors,
photothyristors, solar cells, light emitting
diodes and semiconductor lasers
To identify the characteristics and parameters
of optoelectronic devices.

Task 8 Microprocessors for cell phones
and mobile electronics, conventional
and emerging platforms
Task 9 Volatile memories and nonvolatile electrically and mechanically
addressed memories
Task 10 Non-volatile electrically
addressed memories
Task 3 Non-volatile mechanically
addressed memories

Optoelectronics

TASK OBJECTIVE
To explain the construction, functioning,
characteristics and parameters of MOS ICs and
their application in ICT.
To describe the construction, packaging
technologies and parameters of MCMs and
their application in ICT.
To define the main characteristics and
parameters of microprocessors and to explain
their structure and layout.
To discuss the four main microprocessor
architectures CISC, RISC, VLIW and EPIC
and to explain their hardware implementation.
To identify the six traditional platforms:
desktops, laptops, workstations, servers,
mainframes and super-calculators and their
peculiarities.

Task 1 Liquid crystal devices
Task 2 Semiconductor photodetectors.
Photothyristors, solar cells. Light
emitting diodes. Semiconductor lasers.
Task 3 Complex optoelectronic
devices. Optocouplers.
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VI.

ECAD REMOTE ACCESS GUIDELINES

A. Secure Shell (SSH) settings
 Starting SSH


Displaying tunneling.

Edit => Settings should be selected from the menu.
Tunnelling from the left part of the window (fig. 1) should
be selected as well. After that the Tunnel X11 connections
is to be checked in the check-box to the right.

Figure 3. File => Save settings

The tunnelling will be active as of the next session. If
one has made the changes after connecting to the server,
he/she has to disconnect and connect again.
In case one uses Windows Vista or Windows 7, then it
is needed to edit the settings file manually in a text editor,
since there are problems under those operating systems.
SSH must not be running, because the file will get
overwritten.


Finding default.ssh2 in C:
\Users\<your_windows_profile_name>\AppData\
Roaming \SSH.

In order to do that hidden files have to be visible (Fig. 4).

Figure 1. Tunneling



Tunneling font server (Only for users of Windows
ХР/Vista/7).

Click the Add button in the same window. The
following dialog appears (Fig. 2). It should be filled in as
shown on the figure.

Figure 4.

Showing the hidden files

Find the [Outgoing Tunnels] line and add the
following line:
Tunnel=S:fs,7100,localhost,7100,1,tcp
One empty line must be left below.
Figure 2. New tunnel definition



Starting SSH (Fig. 5)

Save the settings (fig. 3)- File => Save settings

978-1-4673-6109-5 /13/$31.00 ©2013 IEEE
Technische Universität Berlin, Berlin, Germany, March 13-15, 2013
2013 IEEE Global Engineering Education Conference (EDUCON)
Page 1127

VII. LABORATORY PRACTICE WITH CADENCE
The technology used for the laboratory practice in the
system Cadence is 0,35 micrometers.
The first part of the exercise introduces the way of
starting the program, how to create libraries and how you
can plot circuits to proceed to the next part of the exercise,
namely simulations.

Figure 5. SSH

A confirmation is needed the first time one connects to
a server. Then the password should be entered.
B. X-Ming settings.


Running XLaunch from the directory where XMing is installed

The next part is related to different types of analysis
which have to be done. First, ideal elements in the plotting
of the circuits are to be used. A DC analysis next is to be
done to compare the change in the values of the active
load. The AC analysis follows and monitoring how the
circuits work at different frequencies of the input source.
Then the transient analysis is done.
The second part of the exercise repeats the first, but
now real instead of ideal elements are used. All analyses
of the circuit are repeated again.
In the third part of the exercise the students have to
create their symbol of a studied component and replace
the elements of the circuit with their symbol. When
creating a symbol the students have to create and the
layout of the component. Once again the different
analyses of the circuit should be done.
By the end of these parts of the practical work the
students should compare the results obtained with the
ideal, the real and the created by themselves elements of
the circuits.
The next part of the exercise is to perform a parametric
analysis (Fig. 8) under various set setups of the circuit
analysed in the previous steps.

Figure 6. XMing

The default settings should be chosen. For remote font
server (if any) it should be filled in 127.0.0.1 (Fig. 7).

Figure 8. Cadence. Parametric analysis
Figure 7. Remote font server definition

The configuration should saved. It is better to save the
config file where you can have an easy access to it. Its
extension is xlaunch (suggested by default). If SSH is not
running click Cancel, otherwise click Finish.

The last part of the exercise is how to create a layout
of a capacitor and the different types of transistors. How
to plot them layer by layer and how to make the necessary
checks to ensure that the designed circuit is working
properly.

It is important always to start SSH before X-Ming.
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The pilot test starts in February and the master
program will start in the academic year 2013/2014.
VIII. SUMMARY AND CONCLUSION
In this manuscript we presented a work in progress
within the European Community project “Remote-labs
Access in Internet-based Performance-Centered Learning
Environment for Curriculum Support”. The project
focuses on sharing the technological and human resources
available at each partner university to strengthen the
virtual mobility by courses, based on ECTS, delivered by
other institutions abroad using virtual learning facilities,
and to be used in the common MSc programme in
information and communication systems.
The advantages in terms of educational effectiveness
are course organization efficiency, instructors focusing on
area of expertise, common experiences of students of
different countries based on similar infrastructures, tools,
lab organization, learning improvement, thanks to the
optimization of laboratories and courses.
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